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INTRODUCTION

Welcome to the first level of your modular training in Computer Science 2. In this
course, you will be introduced to different learning activities preparing you to be skillful
before you take the plunge into the world of work as a photo editor and to feel more
confident while providing support where needed.

The hand is one of the most symbolized part of the human body. It is often used
to depict skill, action and purpose. Through our hands we may learn, create and
accomplish. Hence, the hand in this learning resource signifies that you as a learner is
capable and empowered to successfully achieve the relevant competencies and skills
at your own pace and time. Your academic success lies in your own hands!

So, explore and experience the K to 12 modules and be a step closer to be a
photo editor.

This module was designed to provide you with fun and meaningful opportunities
for guided and independent learning at your own pace and time. You will be enabled to
process the contents of the learning resource while being an active learner.

This module has the following parts and corresponding icons:

@ What I Need to Know This will give you an idea of the skills or
competencies you are expected to learn in the

module.

What I Know This part includes an activity that aims to
check what you already know about the
lesson to take. If you get all the answers
correct (100%), you may decide to skip this

module.
@ What’s In This is a brief drill or review to help you link
the current lesson with the previous one.
What’s New In this portion, the new lesson will be

introduced to you in various ways such as a
story, a song, a poem, a problem opener, an
activity or a situation.

What is It This section provides a brief discussion of the
lesson. This aims to help you discover and
understand new concepts and skills.

What’s More This comprises activities for independent
practice to solidify your understanding and
skills of the topic. You may check the
answers to the exercises using the Answer
Key at the end of the module.




@ What I Have Learned This includes questions or Dblank
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sentence/paragraph to be filled in to process
what you learned from the lesson.

What I Can Do This section provides an activity which will
help you transfer your new knowledge or skill
into real life situations or concerns.

This is a task which aims to evaluate your

Assessment
level of mastery in achieving the learning
competency.

Additional Activities In this portion, another activity will be given

to you to enrich your knowledge or skill of the
lesson learned. This also tends retention of
learned concepts.

This contains answers to all activities in the
module.

Answer Key

At the end of this module you will also find:

References This is a list of all sources used in developing

this module.

The following are some reminders in using this module:

1.
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Use the module with care. Do not put unnecessary mark/s on any part of the
module. Use a separate sheet of paper in answering the exercises.

Don’t forget to answer What I Know before moving on to the other activities
included in the module.

Read the instruction carefully before doing each task.

Observe honesty and integrity in doing the tasks and checking your answers.
Finish the task at hand before proceeding to the next.

Return this module to your teacher/facilitator once you are through with it.

If you encounter any difficulty in answering the tasks in this module, do not hesitate
to consult your teacher or facilitator. Always bear in mind that you are not alone.

We hope that through this material, you will experience meaningful learning and
gain deep understanding of the relevant competencies. You can do it!



@
What I Need to Know

Objectives

At the end of this module, you are expected to:

*.

+ formulate your learning goals and targets

*

+ explore and examine the basic concepts and underlying principles of photo editing
specifically using the Adobe Photoshop

¢
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apply the concepts and skills learned in photo editing

*
0.0

produce a marketable product or service in photo editing

% appreciate the relevance of learning the basic concepts and skills of photo editing

What I Know

Activity. How Much Do You Know?
A. Direction: Answer the questions based on your current photo editing ability (in any photo
editing program). Use the 4-point Likert Scale below. Write your answer in a separate sheet
of paper.
1 — Not at all 2 — Maybe, with some help
3 — Yes, independently 4 — So well that | could help others
Indicators 1 2 3 4

1. | can use the zoom tool to zoom in and out on a photo.

2.1 can define what a pixel is.

3.l can resize a photo.

4.1 can rotate-flip a photo.

5.1 can crop a photo.

6.1 can turn a photo to black and white and/or sepia.

7.1 can use selection tools to select part of a photo.

8.1 can add special effects to a photo.

9.1 can add text to a photo.

10. | can put a decorative frame and/or mask around a photo.

11. | can use the stamp or clone tool.

12. | can use drawing tools on a photo.

13. | have used photo editing before.

14. 1 can remove red eye on the photo.

15. | can differentiate the RGB to CYMK.




PHOTO EDITING — encompasses the processes of altering images, whether they are digital
photography, traditional photochemical photographs, or illustration. Traditional analog image
editing is known as photo retouching, using tools such as an airbrush to modify photographs, or
editing illustrations with any traditional art medium.

BASIC OF PHOTO EDITING

+ IMAGE EDITING - is the processes of altering images, whether they are digital
photographs, traditional analog photographs or illustrations.

+ TRADITIONAL ANALOG IMAGE EDITING — is known as photo retouching, using tools such
as an airbrush to modify photographs, or editing illustrations with any traditional art
medium.

+ GRAPHIC SOFTWARE PROGRAMS - which can be broadly grouped into vector graphics
editors, raster graphics editors and 3D modelers, are the primary tools with which a user
may manipulate, enhance and transform images.

£ Many image editing programs are also used to render or create computer art from
scratch.

Images are stored in a computer in the form of a grid of picture elements, or pixels. These
pixels contain the image’s color and brightness information. Image editors can change the pixels
to enhance the image in many ways. However, vector graphics software, such as Adobe
Illustrator, CorelDRAW, Xara Designer Pro or inkscape are used to create and modify vector
images, which are stored as descriptions of lines, Bezier, curves and text instead of pixels.

It is easier to rasterize a vector image than to vectorize a raster image; how to go about
vectorizing a raster image is the focus of much research in the field of computer vision. Vector
images can be modified more easily, because they contain descriptions of the shapes for easy
rearrangement. They are also scalable, being rasterizable at any resolution.

DIFFERENCE BETWEEN RASTER AND VECTOR IMAGES

RASTER —raster images used many colored pixels or individual building blocks to form a complete
image. JPEGs, GIFs AND PNGs are common raster image types. Almost all of the photos found
on the web and in-print catalogs are raster images.

VECTOR — vector images, alternately, allow for more flexibility. Constructed using mathematical
formulas rather than individual colored blocks, vector file types such as EPS. Al and PDF are
excellent for creating graphics that frequently require resizing.
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3D MODELING - in 3D computer graphics, 3D modeling is the process of developing a
mathematical representation of any three-dimensional surface of an object (either inanimate or
living) via specialized software. The product is called a 3D model. It can be displayed as a two-
dimensional image through a process called 3D rendering or used in a computer simulation of
physical phenomena. The model can also be physically crated using 3D printing devices.

2D to 3D

IMAGE FORMATS

RASTER

- JPEG (JAY-peg) is a commonly used method of lossy compression for digital images,
particularly for those images produced by digital photography.

- Portable Network Graphics (PNG /’pin) is a raster graphics file format that supports
lossless data compression. PNG was created as an improved, non-patented replacement
for Graphics Interchange Format (GIF) and is the most used lossless image compression
format on the internet.

- GIF alossless format for image files that supports both animated and static images.

- The BMP file format, also know as bitmap image file or device independent bitmap (DIB)
file format or simply a bitmap, is a raster graphics image file format used to store bitmap
digital images, independently of the display device (such as a graphics adapter), especially
on Microsoft Windows and OS/2 operating systems.

VECTOR

- Encapsulated Postscript Vector graphics (Adobe Illustrator) EPS is a file extension for a
graphics file format used in vector-based images in Adobe Illustrator. EPS stands for
Encapsulated Postscript. An EPS file can contain text as well as graphics.

- Scalable Vector Graphics (SVG) is an XML-based vector image for two-dimensional
graphics with support for interactivity and animation. The SVG specification is an open
standard developed by the World Wide Web Consortium (W3C) since 1999. SVG images
and their behaviors are defined in XML text files.

3D

- .3ds is one of the file formats used by the Autodesk 3ds Max 3D modeling, animation and
rendering software.

- .fbx is an exchange format, in particular for interoperability between Autodesk products
and other Digital content creation (DCC) software packages.



Overview of Adobe Photoshop

Adobe Photoshop is a seriously powerful photo and image editing application. Let us have
a quick look at what Photoshop is, and what it is not. Remember that Photoshop is not a drawing
program.

This is a very common source of confusion and frustration. Although it is possible to use
Photoshop to design and construct original graphics, you will find that it is difficult and limited.
The reason is that Photoshop is not intended to be used for this type of work. Photoshop is an
image editing tool, not a design tool. To create original images, Adobe provides other specialist
programs such as Adobe lllustrator and Adobe Image Ready.

MENU BAR
OPTION BAR

PANELS =)

.. 4mm TOOL BAR

WORKSPACE OR
WORK AREA

!

ELEMENTS OF THE INTERFACE

A. MENU BAR

Contains menus for performing common tasks.

e Consists of eleven menu options: File; Edit; Image; Layer; Type; Select; Filter; 3D;
View; Window; Help

e Menu items containing an ellipsis (three consecutive dots) indicate that a
dialogue box will follow that option.

e Menu items with an arrow indicate a submenu for that particular option.

File Edit Image Layer Type 5 ilE iID View Window Help

1. File Menu — New (Starting a new file), Open (Opening a previous file), Save (Save file)
and Print.

2. Edit Menu — Copy, Paste, Cut and Transform.

3. Image Menu — Adjustments, Image Size, Canvas Size and Image Rotation.

4. Layer Menu — New Layer, Duplicate Layer, Delete, Rename Layer, Merge Down and
Group Layers.

5. Type Menu — Panels, Type Orientation, Font Preview Size and Language Options.
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Select Menu — Alll, Reselect, Deselect, Inverse and Color Range.

Filter Menu — Filter Gallery, Blur, Distort, Noise, Pixelate, and other Filters.

3D Menu — New 3D Layer from File, New Mesh from Layer and New Title Paint from
Layer

9. View Menu — Zoom In, Zoom Out, Fit to Screen, Actual Pixels and Print Preview.

10. Window Menu — Arrange, Workspace (Palates) and Extensions

11. Help Menu — Online Help, Support Center and About Photoshop

® ~

B. OPTIONS BAR

Works in coordination with your tool bar to provide additional settings for the tool
you're currently using.

e The options bar changes according to whichever tool you are using.

=7 | >
F| 7 C. TOOLBAR
& | 5% Perhaps the most important element of the Photoshop interface is the
=7 || TOOLBAR. The tool bar is located by default on the left-hand side of the work
O .| *. ] area. It contains mouse-based tools that are used for editing and navigation in
,_* 1T, Photoshop. Most of the tool icons have a small black down-pointing arrowhead
i = ;‘ in the bottom right-hand corner. This indicates that these are more tools that
i‘")l q‘ can be accessed by clicking and holding down the mouse button. Once the
- extended tools have appeared, you may release the mouse button and the tools
L—i|—_|_| will remain.
jjﬁ_{ Listed below are the tools located in the tool bar, an image of the tool,
functions of that tools, and a brief description of the tool functions.

Move- Allows the user to move selected elements around the selected layer.

E Rectangle Marquee-Allows the user to select rectangular shaped sections area of the
layer in the image .

Lasso- allows the user to draw freeform section borders within the image.

Magic Wand — Allows the user to select sections of and image based on color.

r”
Crop- Allows the user to alter an image by excluding desired parts



n Eye Dropper- Allows the user to sample or select a specific color within an image.

Spot healing Brush-Allows the user to quickly repair small imperfections in an image.
8l Brush- Allows the user to paint different kinds of brush strokes of the foreground color.
.
Clone Stamp-Allows the user to copy portions of the image.
® History Brush- Allows the user to draw/paint with sample data from the image.
ﬂ Eraser- Allows the user to erase desire pixels in an image.

E Gradient- Allows the user to fill a desired space with the gradient of the color or pattern
of choice.

“ Blur- Allows the user to blur or soften desires sections of the image.
Dodge- Allows the user to lighten desired parts of the image.
SN Pen- Allows the user to create complex shapes and create paths.
Horizontal Text-Allows the user to horizontally type on the layer or image.
E Path Selection- Allows the user to select a path to use other tools.
E Rectangle- allows the user to create rectangles of different sizes.
u Hand- allows to user to drag/ move images in the window.

- Zoom-Allows the user to increase or decrease the size of the view of the file.

Set Foreground Color/Set Background Color- allows the user to select or change the
colors for the foreground and background



D. Panels
Helps you monitor and modify your work
e Provides groups of functionalities specific to certain tools or tasks.
* You can create a custom workspace by moving and manipulating
panels.

OPTIMIZE PHOTOSHOP PERFORMANCE

Tweak your operating system, hardware, and application settings to help your
computer run Photoshop stably at the optimum speed. If Photoshop is running slower than
expected on your computer, or if you're experiencing system freezes, lags, or delays while
using Photoshop, try the tips and techniques outlined in this document.

Tweak —improve a mechanism or system by making fine adjustments to it.

There are four primary ways to affect performance in Photoshop:

1. Fine-tune Photoshop features

Disable Rulers and Overlays
Having rulers and overlays (such as Grids, Slices and Smart Guides)
visible can slow some operations, such as painting, transform, and dragging
layers on the canvas.
e To disable rulers, in the View menu, deselect Rulers.
e To disable overlays, go to the View > Show menu, select None or disable
the individual items.

Minimize or turn off panel preview thumbnails

Each time you change a document, Photoshop updates all the thumbnails
visible in the Layers and Channels panels. This update can affect responsiveness
when you’re rapidly painting, moving, or nudging layers. The more thumbnails
visible, the greater this effect.

To minimize or disable these thumbnail previews, click the Panel menu and
choose Panel Options. Select a smaller thumbnail size or select None, and then
click OK.

If you want Photoshop to always use less memory, choose Edit >
Preferences > Performance (Windows) or Photoshop > Preferences >
Performance (macOS) and move the Memory Usage slider to the left.

2. Optimize your hardware setup
Use a fast processor

The speed of the computer's central processing unit, or CPU, limits the
processing speed of Photoshop.



Photoshop generally runs faster with more processor cores, although some
features take greater advantage of the additional cores than others. However, you'll
get diminishing returns with multiple processor cores: The more cores you use, the
less you get from each additional core. Therefore, Photoshop doesn’t run four times
as fast on a computer with 16 processor cores as on a computer with four cores. For
most users, the increase in performance that more than six cores provide doesn’t
justify the increased cost.

3. Optimize your operating system for Photoshop

Use the following information to set up and use your operating system efficiently
with Photoshop.

¢ Close unnecessary applications and startup items
Other open applications and startup items decrease the amount of
memory available to Photoshop. To free up additional memory, quit
unnecessary applications, startup items, and extensions
e Run Disk Cleanup (Windows)
From time to time, run Disk Cleanup to remove temporary files and any
other files that are not being used.
e Defragment the hard disk (Windows)
Photoshop takes longer to read or write a fragmented file than one saved
to a contiguous location.
e Turn on automatic OS updates
Updates to the Windows or macOS improve performance and
compatibility with applications

4. Set power options
Ensure that Photoshop is using the High-Performance graphics card rather
than lower powered Integrated graphics card for computers that have two graphics
cards.
Windows Update won't always give you the latest and greatest drivers. You
must go directly to your card manufacturer’s website to check for driver updates:
v" NVIDIA drivers
https://www.nvidia.com/download/index.aspx?lang=en-us
v' AMD drivers
https://www.amd.com/en/support
v'Intel drivers
https://downloadcenter.intel.com/



https://www.nvidia.com/download/index.aspx?lang=en-us
https://www.amd.com/en/support
https://downloadcenter.intel.com/

What I Have Learned

Directions: Inspect the Photoshop Window Interface and determine what is the basic parts
where the arrow is pointing. Write your answer in a separate sheet of paper

“7‘ What I Can Do

Directions: Match the photoshop tools in Column B to their uses in Column A. Write your
answer in a separate sheet of paper.

10.

Column A

. It allows the user to alter an image by

excluding desired parts.

. This is used to lighten desired parts of the

image.

. This tool is used to move selected elements

around the selected layer.

. It allows the user to horizontally type on the

layer or image.

. This tool is used to quickly repair small

imperfections in an image.

. It allows the user to copy portions of the

image.

. This tool is used to select sample or select a

specific color within an image.

. It allows the user to create complex shapes

and create paths.

. This tool allows the user to draw/paint with

sample data from the image.
It allows the user to select or change the
colors for the foreground and background.

m o O o >»
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Column B

. History Brush

. Spot Healing Brush
. Clone

.Zoom

. Set Foreground Color/Set

Background Color
Crop

. Brush

. Horizontal Text

Dodge

Pen

. Move

. Eye Dropper




Assessment

A. Directions: Identify what is being described in the following sentences and write your
answer on a separate sheet of paper.

1.

2.
3.

S

8.

9.

It encompasses the processing of altering images, whether they are digital
photography, traditional photochemical photographs or illustration.

It is a seriously powerful photo ang image editing application.

It indicates that a dialog box will follow menu if you see these three consecutive
dots in any of the menu bar tab.

This bar consists of 11 menus for performing common tasks.

This bar works in coordination with your tool bar to provide additional settings for
the tool you are currently using.

This image uses many colored pixels or individual building blocks to form a
complete image.

It is the process of developing a mathematical representation of any three-
dimensional surface of an object via specialized software.

This image format is the commonly used method of lossy compression for digital
images particularly for those images produces by digital photography.

The most important element of Photoshop interface and is located by default on
the left-hand side of the work area.

10. This means improving a mechanism or system by making fine adjustments to it.

B. DIRECTIONS: Enumerate the four (4) primary ways to affect performance in
Photoshop. write your answer on a separate sheet of paper.

1.

2.
3.
4
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